
 

CCS371 VIDEO CREATION AND EDITING 

UNIT - I FUNDAMENTALS 9 

Evolution of filmmaking - linear editing - non-linear digital video - Economy of 

Expression - risks associated with altering reality through editing. 

 

Part A 

 

1. What are the ways to study film history? 

Aesthetic 

Technological 

Economic 

Social History 

2. What is linear editing in film? 

Linear video editing is a video editing post-production process of selecting, arranging and 

modifying images and sound in a predetermined, ordered sequence. Regardless of 

whether it was captured by a video camera, tapeless camcorder, or recorded in 

a television studio on a video tape recorder (VTR) the content must be accessed 

sequentially. 

3. Differentiate Linear and nonlinear video editing 

Editors who use linear editing can maximize quality by completing the project in as few 

dubs as possible. Nonlinear editing is more effective at preserving the quality of the 

original recording because it maintains your original files. 

4. Compare linear and nonlinear video 

While linear editing is tied to the need to sequentially view film or hear tape, non-linear 

editing enables direct access to any video frame in a digital video clip, without having to 

play or scrub/shuttle through adjacent footage to reach it, as is necessary with video tape 

linear editing systems. 

5. List down the stages of video post-production 

Logging footage. 

Assembling footage. 

Rough cut. 

Fine cut. 

Final cut. 

6. Define video editing 

Video editing includes cutting segments (trimming), re-sequencing clips, and adding 

transitions and other special effects. 
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7. List down nonlinear video editing tools 

Adobe Premiere Pro 

Apple's Final Cut Pro X. 

Avid’s Media Composer 

DaVinci Resolve 

Lightworks 

 

8. Relate the term “Economy of expression” with respect to video editing 

Four different types of economic impacts generated by the film and video production and 

distribution industry were estimated based on the 2008 information. These impacts 

include: (1) output impacts; (2) employment impacts; (3) employee and freelancers 

compensation impacts; and (4) value added impacts. The results are disaggregated to 

identify the direct economic impact of the film and video production and distribution 

industry, the indirect (supply chain) impact of the industry, and the induced (re-spending) 

impact of the industry. The total impact of the industry is then the sum of direct, indirect, 

and induced impacts. 

9. What are the risks associated with video editing? 

Video editing is a meticulous and time-consuming process. From organizing footage to 

making precise edits, the editing phase can take significantly longer than the actual 

shooting. Editors often spend hours reviewing and refining footage, ensuring seamless 

transitions, and achieving the desired pacing and impact. 

10. Examine the disadvantages of video editing 

Video editing is a meticulous and time-consuming process. From organizing footage to 

making precise edits, the editing phase can take significantly longer than the actual 

shooting. Editors often spend hours reviewing and refining footage, ensuring seamless 

transitions, and achieving the desired pacing and impact. 

11. List down the video creation and editing software 

Adobe Premiere Pro. 

Final Cut Pro X. 

Adobe after Effects. 

Lightworks. 

Freemake. 

iMovie.. 

 

12. Identify the role of video editing in film making 

It is the step of transforming the raw footage into film footage with a logical sequence. 

The film editor selects and edits shots to combine them into scenes and sequences, using 

various editing techniques and making editing decisions in line with creative instructions 

and the director's vision 

 

13. Describe about video editing 

Video editing is the post-production and arrangement of video shots. To showcase perfect 

video editing to the public, video editors must be reasonable and ensure they have a 

superior understanding of film, television, and other sorts of videography. 
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14. How to measure the editing quality of video 

Video quality can be evaluated objectively (by mathematical models) or subjectively (by 

asking users for their rating). Also, the quality of a system can be determined offline (i.e., 

in a laboratory setting for developing new codecs or services), or in-service (to monitor 

and ensure a certain level of quality). 

15. Define video creation 

Video productionis simply everything that goes into the ideation, planning and execution 

of a video. Historically video production involves three phases: Pre-production, 

Production and Post-production. 

 

 

PART B 

1. Write Notes on evolution of film making 

2. Explain video editing process with various stages 

3. Demonstrate linear video editing techniques with its advantages and disadvantages 

4. Differentiate linear and nonlinear editing. Mention the application of both techniques in 

detail 

5. What are the prerequisite for video creation and editing? Explain in detail 

6. Examine the commercial requirements of video editing? How to attain those 

requirements? 

7. What is meant by economy of expression? Identify the ways to achieve in video editing. 

8. Analyze the risks associated with altering reality through editing. 

 

 

 

 

 

 



 

UNIT - II STORYTELLING 9 

Storytelling styles in a digital world through jump cuts, L-cuts, match cuts, cutaways, 

dissolves, split edits - Consumer and pro NLE systems - digitizing images - managing 

resolutions - mechanics of digital editing - pointer files - media management. 

 

Part A 

 

1. What is storyboard in film making? 
A storyboard is a graphic representation of how your video will unfold, shot by 

shot. It's made up of a number of squares with illustrations or pictures representing 

each shot, with notes about what's going on in the scene and what's being said in 

the script during that shot. 

2. Mention the storytelling techniques 

According to Masterclass, there are at least 4 ways to communicate through 

story: oral storytelling, visual storytelling, written storytelling, and digital 

storytelling. However, there are many other types of storytelling as well, such as 

musical storytelling, dance storytelling, and more. 

3. What are the benefits of storyboard? 

Storyboards are a great way to plan out a video before shooting it. They can help 

you visualize what the final product will look like and ensure that all the elements 

come together cohesively. 

4. Define jump cut 
A jump cut is a cut in film editing that breaks a single continuous sequential shot of 

a subject into two parts, with a piece of footage removed to create the effect of 

jumping forward in time. Camera positioning on the subject across the sequence 

should vary only slightly to achieve the effect. 

5. Examine the purpose of non-linear editing system (NLE) 

A non-linear editing system (NLE) is a video editing (NLVE) program or 

application, or an audio editing (NLAE) digital audio workstation (DAW) system. 

These perform non-destructive editing on source material. The name is in contrast 

to 20th-century methods of linear video editing and film editing. 

6. Show the purpose of L cut in editing 

An L-cut is also a split edit. In this technique, the audio from one shot continues 

under the video of the next one. What the viewer experiences is hearing the audio 

from the preceding scene while watching video that has already cut to something 

else. 

 

7. What is match cut in editing? 
In film, a match cut is a cut from one shot to another in which the composition 

of the two shots are matched by the action or subject and subject matter. For 

example, in a duel a shot can go from a long shot on both contestants via a cut 

to a medium closeup shot of one of the duelists 

 

8. Differentiate cross cut and cutaway 

It's common to confuse cutaway shots with cross-cutting, because in cross-cutting 

you are technically cutting away and coming back. But cross-cutting is an editing 

technique often used to establish action occurring at the same time, and mostly in 

two different locations. 

9. How to use dissolve technique in editing? 
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A dissolve is a classic editing technique used to transition between shots, typically 

shots that bridge two scenes together. As opposed to a straight cut from one shot to 

another, a dissolve involves the gradual transition from the first image to the next. 

 

 

 

10. Tell about image digitization 

Digitization is the process that generates a digital image by measuring and 

quantizing an optical image. Display is the process of generating a visible image by 

interpolating a digital image. A number of factors affect the quality of the digital 

and displayed images produced. 

 

11. Illustrate the role of resolution in editing 

In digital photography, resolution is the level of detail contained in an image. More 

specifically, it refers to the number of pixels that exist within that image. The 

higher the resolution, and the richer the pixel count, the more detail and definition 

you will see. 

12. Define aspect ratio 

The aspect ratio of an image is the ratio of its width to its height, and is expressed 

with two numbers separated by a colon, such as 16:9, sixteen-to-nine. For the x:y 

aspect ratio, the image is x units wide and y units high. 

13. Describe the method of video editing 

Video editing includes cutting segments (trimming), re-sequencing clips, and 

adding transitions and other special effects. Linear video editing uses video tape 

and is edited sequentially. Several video clips from different tapes are recorded to 

one single tape in the order that they will appear. 

 

14. Relate media management with film 

Media and internet management covers all the goal-oriented activities of planning, 

organization and control within the framework of the creation and distribution 

processes for information or entertainment content in media enterprises. 

15. List down various cuts used in video editing 

Some of the different types of cuts in film include the standard or hard cut, jump 

cuts, J & L cuts, cutaways, cross cuts, cutting in action, montages, cut-ins and 

smash cuts. 

 

 

Part B 

1. Explain the purpose of story board in digital video editing with suitable diagrams 

2. Discuss about various story telling techniques 

3. Demonstrate various cuts used in video editing with applications 

4. Which software is best for NLE? Justify with pros and cons 

5. Write about digitization process of images with necessary steps 

6. Describe about different types of resolutions. Mention advantages and 

disadvantages of higher video resolution 

7. Explain the terms i) pixel, ii) video resolution iii)P and I in resolution iv) Aspect 

ration 

8. Summarize the uses media management in video editing 
9. Analyze in detail about five phases of video editing 



 

 

 

 

UNIT - III  USING AUDIO AND VIDEO  9 

Capturing digital and analog video importing audio putting video on exporting digital video 

recording to CDs and VCDs. 

Part A 

1. Differentiate digital and analog video 
In analog, information is translated into electric pulses of varying amplitude. W 

digital, translation of information is into binary format (0 or 1) where each 

representative of two distinct amplitudes. 

2. What is the difference between digital audio and analog audio? 

Sound waves are a series of vibrations through a medium. Analog audio recording 

technology stores this information by creating a series of magnetic charges along a reel of 

magnetic tape. Digital audio technology stores audio information as a series of numeric 

values on a hard drive. 

3. What are the best practices for video storage? 

The 3-2-1 data strategy, as it’s known, calls for two versions of a file to be stored locally 

(on different devices) and a third stored offsite. 

4. How to store digital video files? 

Dropbox. Google Drive. 

Adobe Creative Cloud.  

IDrive. Box. 

Apple iCloud. 

5. Compare CD and VCD storage 

The CD's metal or recording layer is located on the top of the disk. The metal layer or 

recording layer in the DVD is located in the middle of the disk. The CD is capable of 

acquiring around 700 MB of data. The DVD is capable of acquiring 4.7 GB to 17 GB of 

data. 

6. Find the ways to transfer a tape recording to computer 

In order to record the audio from the cassette tape to your computer, connect the male RCA 

side of the cable (red and white) into the female RCA connectors on the tape deck. Make 

sure the RCA jacks on the tape deck say “Line Out” or “Audio Out.” Connect the other end 

of the cable to your computer. 

7. Mention the advantages of digital video over analog video. 

First, digital video makes more efficient use of storage and transmission space than analog 

video because it is composed of discrete pulses rather than continuous waves. In its natural, 

uncompressed state digital video requires less recording and transmission “space” than 

analog video. 

8. How to transfer video files from mobile to laptop? 

With a USB cable, connect your device to your computer. On your device, tap the 

"Charging this device via USB" notification.Under "Use USB for," select File Transfer. A 

file transfer window will open on your computer 

 

 

 

9. How do you convert analog-to-digital signal? 

https://www.backblaze.com/blog/the-3-2-1-backup-strategy/


 

 
To convert an analog signal to a digital one, measurements must be sampled at a regular 

frequency. The sample rate must be at least twice its frequency. This approach is used in 

digital audio and video to reduce aliasing, or the production of a false frequency. 

10. List down various audio file formats 

There are three major groups of audio file formats: 

 

Uncompressed audio formats, such as WAV, AIFF, AU or raw header-less PCM; 

 

Formats with lossless compression, such as FLAC, Monkey's Audio (filename 

extension .ape), WavPack (filename extension .wv), TTA, ATRAC Advanced 

Lossless, ALAC (filename extension .m4a), MPEG-4 SLS, MPEG-4 ALS, MPEG-4 

DST, Windows Media Audio Lossless (WMA Lossless), and Shorten (SHN). 

 

Formats with lossy compression, such as 

Opus, MP3, Vorbis, Musepack, AAC, ATRAC and Windows Media Audio Lossy (WMA 

lossy). 

 

11. Examine the importance of compression in handling video files? 

The purpose of compression is to make the video occupy less space than the original file 

and to facilitate its transmission over the Internet. Here's how it works. Videos are 

compressed using codecs and video codecs are the compression component of video 

compression software. 

12. Identify audio editing softwares 

Best Overall: Audacity. 

Best Free: GarageBand. 

Best for Live Music: Adobe Audition. 

Best for Podcasts: Hindenburg Pro. 

Best for Music Production: Ableton Live. Best for Professionals: Pro 

Tools. 

Best for Apple Devices: Logic Pro. Best for Android Devices: AudioLab. 

 

 

 

 

 

 

 

 

 

13. what are the video capture device? 

A capture device (also referred to as a capture card) is a hardware device that you connect 
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to your computer that converts the video signal from your camera's output into a digital 

format your computer can recognize. 

14. List out various MPEG standards 

 MPEG-1 −This standard is primarily used for audio and video compression for CD-ROMs and 

low-quality video on the internet. 

 MPEG-2 −This standard is used for digital television and DVD video, as well as high- 

definition television (HDTV). 

 MPEG-4 −This standard is used for a wide range of applications, including video on the 

internet, mobile devices, and interactive media. 

 MPEG-7 −This standard is used for the description and indexing of audio and video 

content. 

 MPEG-21 − This standard is used for the delivery and distribution of multimedia content over 

the internet. 

 

15. Differentiate between Lossy Compression and Lossless Compression 
 

S.NO Lossy Compression Lossless Compression 

 

1. 
Lossy compression is the method which 

eliminate the data which is not noticeable. 

While Lossless Compression does no 

eliminate the data which is not noticeable. 

 

2. 
In Lossy compression, A file does not 

restore or rebuilt in its original form. 

While in Lossless Compression, A file can 

be restored in its original form. 

 

3. 
In Lossy compression, Data’s quality is 

compromised. 

But Lossless Compression 

compromise the data’s quality. 

does no 

 

4. 
Lossy compression reduces the size of 

data. 

But Lossless Compression does not reduce 

the size of data. 

 

 

5. 

Algorithms used in Lossy compression 

are: Transform coding, Discrete Cosine 

Transform, Discrete Wavelet Transform, 

fractal compression etc. 

Algorithms used in Lossless compression 

are: Run Length Encoding, Lempel-Ziv 

Welch, Huffman Coding, Arithmetic 

encoding etc. 

 

6. 
Lossy compression is used in Images, 

audio, video. 

Lossless Compression is used in Text 

images, sound. 

 

7. 

 
Lossy compression has more data-holding 

capacity. 

Lossless Compression has less data 

holding capacity than Lossy compression 

technique. 
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8. 
Lossy compression is 

irreversible compression. 

also termed as Lossless Compression is also termed a 

reversible compression. 

 

Part B 

1. Explain audio compression techniques in detail 

2. How to store files in CD and VCD? Compare its performance 

3. Discuss about the ways to record audio files. Demonstrate any one method in detail 

4. Compare various video compression techniques 

5. Write about various video file formats supported by android phone . List the steps to convert 

video files to different formats 

6. Examine the method to import and export video files from laptop to mobile phone 

7. Identify various video storage devices. Analyze its performance in various aspects 

8. Enumerate the difficulties faced by editors with audio and video files 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

UNIT -IV WORKING WITH FINAL CUT PRO 9 

 

Working with clips and the Viewer - working with sequences, the Timeline, and the canvas - Basic 

Editing - Adding and Editing Testing Effects - Advanced Editing and Training Techniques - 



 

Working with Audio - Using Media Tools - Viewing and Setting Preferences. 

 

Part A 

1. What are the benefits of Final cut pro editing tool? 

Great layout for editing. Easy to access all the tools without switching screens. 

Has a nice variety of built in transitions. 

Easy to add audio and video clips. 

2. How do you play clips in Final Cut Pro? 

 

In Final Cut Pro, open a project in the timeline or select a clip in the browser, then position the 

playhead where you want the video to begin. Do one of the following: Choose View > Playback > 

Play Full Screen (or press Shift-Command-F). Click the Play Full Screen button below the lower- 

right corner of the viewer. 

 

3. Mention the steps to import and export sequence in Final cut pro tool 

To import a file into Final Cut Pro, choose File > Import > Media, navigate to the file you want to 

import, select the file, then click Import . 

To export 

Choose File > Share > Export Image Sequence. 

4. what is purpose of canvas in final cut pro? 

In Final Cut Pro, the Canvas is the equivalent of a record monitor in a tape-to-tape editing suite; 

it displays the video and audio of your edited sequence during playback. When you open a new 

sequence, it appears simultaneously in tabs in both the Canvas and the Timeline. 

5. Show the purpose of precision editor in Final Cut Pro 

You can fine-tune the edit point between two clips in the timeline using the precision editor, 

which provides an expanded view of the clips on either side of the edit point as well as the unused 

portions of each clip. 

6. How the ripple edit tool performs in Final Cut Pro? 

 

The default type of trim in Final Cut Pro is a ripple edit, which adjusts a clip's start point or end 

point without leaving a gap in the timeline. The change in the clip's duration ripples outward, 

moving all subsequent clips earlier or later in the timeline. 

7. Enumerate the reasons for using Final Cut Pro in professional editing 

Final Cut Pro is a good video editing program, relatively easy to learn, and comes at a significantly 

more affordable price than some of its competitors. As such, it is a great choice for novice editors, 

hobbyists, and those just wanting to learn more about the craft. But it is also good for professional 

editors. 

 

 

8. How do you add media in Final Cut Pro? 

If the media you want to import is on an external storage device or a memory card, connect the 

device to your Mac and turn on the device. In Final Cut Pro, do one of the following: Choose File 

> Import > Media (or press Command-I). Click the Import Media button on the left side of the 



 

toolbar. 

9. List down the audio files supported by final cut pro 

AAC. 

AIFF. 

BWF. 

CAF. 

MP3. 

MP4. 

RF64 (requires macOS High Sierra 10.13) 

WAV. 

10. What is new media tools? 

The new media technologies, sometimes known as Web 2.0, include a wide range of web-related 

communication tools such as blogs, wikis, online social networking, virtual worlds, and other 

social media platforms. The phrase "new media" refers to computational media that share material 

online and through computers. 

 

11. Justify the reason to use final pro cut 

Final Cut Pro X supports playback of many native camera and audio formats. It can also transcode 

video clips to the Apple ProRes codec for improved performance. Many tasks are performed in the 

background such as auto-saving, rendering, transcoding, and media management, allowing the 

user an uninterrupted experience. 

12. Mention the ways to improve video quality using final cut pro 

Apply advanced editing techniques like trimming and color correction to enhance the quality of 

video footage. Edit and manipulate audio tracks and apply audio effects and filters to improve 

sound quality. 

13. Demonstrate to set proper audio levels in Final Cut Pro 

In the Final Cut Pro timeline, select one or more audio clips or video clips with audio. Do one of 

the following: Adjust the volume in +1 or –1 dB increments: Choose Modify > Adjust Volume, 

then choose Up or Down, or press Control-Plus Sign (+) or Control-Minus Sign (–). 

14. Is Final Cut Pro good for audio editing? 

Users can make audio adjustments and edits to whole clips. At this level, audio adjustments and 

effects are applied to the entire clip, including any audio channels within the clip. Final Cut Pro 

preserves any adjustments you make to individual audio channels. 

 

15. Compare Final cut pro with avid xpress dv tool 

Avid Media Composer is the software that allows users to easily create, manage, and edit videos 

and images. Final Cut Pro is among the several video editing programs available today on the 

market. It is a multi-functional software that can be used for both video recording and editing. 

 

 

 

 

 

 



 

 

Part B 

1. Compare various video editing software's 

2. Write notes on evolution of Final cut pro editing tool 

3. Explain about animation effects created by Final cut pro editing tool 

4. Discuss about built in effects associated with Final cut pro editing to improve video quality 

5. Compare Final cut pro vs Adobe premiere pro video editing tools 

6. Describe the steps to use final cut pro for video editing 

7. Explain the tools used in final cut pro software 

8. Analyze the features, pros and cons of final cut pro software 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

UNIT -V WORKING WITH AVID XPRESS DV 

 

Starting Projects and Working with Project Window - Using Basic Tools and Logging - 

Preparing to Record and Recording - Importing Files - Organizing with Bins - Viewing and 

Making Footage - Using Timeline and Working in Trim Mode - Working with Audio - 

Output Options. 

Part A 



 

 

1. Define the purpose of Avid Xpress Pro editing tool 

Avid Xpress Pro was a non-linear video editing software aimed at professionals in the 

TV and movie industry. It was available for Microsoft Windows PCs and Apple 

Macintosh computers. 

2. Mention the displays available in project window of Avid Xpress Pro editing 

tool 

The Project window provides three different displays (Bins, Settingsand Info) for 

structuring and viewing information about your currentproject. 

3. What is the use of Bins in AvidXpress Pro? 

Bins are where you keep your footage (and music, sound effects, titles etc) and 

sequences. You can create folders in the project window in order to group and 

arrange bins but you can't store clips directly in folders, only in bins. Bins contain 

the master clips that are created when you record sourcematerial. (The master clips 

are linked to the media files.) Bins alsocontain the sequences, subclips, group clips, 

and effect clips that youcreate during a project. 

4. List down the basic tools supported by Avid Xpress Pro 

Navigaring in dialog boxes and menus 

Tools menu 

Command Palette 

Avid Calculator 

Console Window 

Hardware tool 

5. Define button mapping 

Keyboard Manager allows you to customize the keyboard to be more productive by 

remapping keys and creating your own keyboard shortcuts.Mapping user-

selectable buttons allows you to reconfigure Commandpalettes or the keyboard in 

various combinations to suit differentediting needs. 

6. What is IEEE standard 1394? 

IEEE 1394 is an internationally standardized, low-cost digital interfacethat 

integrates entertainment, communication, and computingelectronics into consumer 

multimedia. IEEE 1394 is a hardware andsoftware standard for transporting data at 

100, 200, or 300 megabitsper second (Mb/s). Because it’s a digital interface, there 

is no need toconvert digital data into analog, resulting in a loss of data integrity. 

7. What is an .ALE file? 

“An Avid Log Exchange (ALE) file is a text-based metadata exchange format used 

to transfer film, video, and audio data between systems. It contains important 

information about the media, such as Name, Filepath, Video Format, Duration, 

Timecode, Scene, Take, Notes, Comments, LUT information, and more.” 

 

 

 

 

 

8. Differentiate resolution and video quality 

The resolution is the pixel size. In layman language, that's the size of an image on 

the screen. Video quality, however, is the quality of the image or the quality of the 

pixels. Better quality pixels are ones that store lots of details such as color, contrast, 

and shadow to name. 

9. Examine the implication of open media management initiative by Avid 
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Open Media Management™ (OMM™) is an Avid initiative to create astandard 

programming interface for integrating asset managementsystems with Avid editing 

systems. Avid has partnered with leading 

asset management companies to implement the OMM standard.OMM allows you 

to exchange video and audio clips with an assetmanagement application. 

10. Identify the options for backing up media files 

 Consolidating or making copies of media files for transfer toanother system 

 Archiving larger media files and folders to a dedicatedmass-storage system 

11. Describe the role of slate in video editing 

A clapperboard, also known as a dumb slate, clapboard, film clapper, film slate, 

movie slate, or production slate, is a device used in filmmaking and video 

production to assist in synchronizing of picture and sound, and to designate and 

mark the various scenes and takes as they are filmed and audio-recorded. 

12. Show the working of JKL Keys with respect to playback 

Press the J key to move backward at the same shuttle speed increments. Press the 

K key to stop playback. Press the K and L keys together for slow forward at ¼ 

times normal speed. Press the K and J keys together for slow backward at ¼ times 

normal speed. 

13. What is audio automation? 

In music production, automation is the process of making changes in your mix 

occur automatically over the course of the song. One of the most common uses of 

automation is to adjust volume levels. Using automation, you can tell your DAW 

to turn tracks up or down as the song plays. 

14. Find the advantages of Trim mode over rough cut 

Basic editing in the Timeline initially produces a rough cut, which can be loosely 

defined as a series of straight-cut edits with many roughedges and few effects. 

After creating a rough cut, you can enter Trimmode and fine-tune the transitions 

between each clip or betweenwhole segments. You can also trim edits as you build 

a sequence,rather than create a rough cut first. 

15. Describe the purpose of Broadband Noise Reduction (BNR) 

The BNR feature of the Digidesign Intelligent Noise Reduction™(DINR) plug-in 

provides broadband and narrow-band noise reductionfor suppressing unwanted 

elements such as tape hiss, air conditioningrumble, and microphone preamplifier 

noise. 

 

 

 

 

 

 

 

 

 

 

Part B 

1. Write about the features and uses of Avid Xpress DV 4 video editing software 

2. Explain the starting of a new project in Avid Xpress DV 4 video editing tool 

3. Compare avid xpress dv 4 video editing software with adobe premiere Pro 

4. Analyze the importance of Bins display in avid xpress dv 4 and explain working 

with Bin in detail 



 

5. Demonstrate i)Setting up the record tool ii) Preparing for audio tool 

6. Discuss the following terms with respect to avid xpress dv 4 

i) Text view ii)Frame view iii)Script view iv)Custom bin view 

 

7. Explain about script integration in detail in avid xpress dv 4 

8. How media files are managed by avid xpress dv 4? 

9. Write Notes on viewing and managing footage in avid xpress dv 4 

10. Illustrate the use of timeline in avid xpress dv 4 
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